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1 Document Information

1.1 Purpose and Scope

This document provides a step by step description on how to integrate Endress+Hauser PROFIBUS devices
with the Schneider Electric Modicon M580 system. All content of this document is jointly developed,
reviewed and approved by Schneider Electric and Endress+Hauser as a common deliverable of Open
Integration.

1.2 Document History

This is version 1.00.00 of this document. Version history:

Version Released Description

1.00.00 2015-12 Initial version

1.3 Related Documents

Please refer to related documents as listed below:

Document Description

SD01462S/04/EN/01.15 | Reference Topology SEO1

SD01464S/04/EN/01.15 | Integration Test Summary SEO1

SD01465S/04/EN/01.15 | List of Tested Devices and Versions SEO1
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2 Pre-Requisites

Readers of this document should be familiar with related documents as listed in chapter 1.3 and basics on
how to work with the Schneider Electric Modicon M580 System and PROFIBUS in general. Please refer to
recommended literature as listed in chapter O.

2.1 Recommended Literature

2.1.1 Schneider Electric

Document Description

EI00000001854.02 Modicon M580 Remote I/0 Modules (Hardware)
35006238.12 Modicon M580 and Premium/Atrium using Unity Pro
S1A64489.02 Profibus Remote Master User Manual

2.1.2 Endress+Hauser

Document Description
BA00065S FieldCare Project Tutorial
BA00070S Fieldgate SFG500 Installation and Commissioning

2.1.3 Other

2.1.3.1 Pepperl+Fuchs

Document Description

tdoct0835g_eng.pdf POWERHUB Segment Coupler Manual

2.2 Operable Control System

This document assumes an operable Schneider Electric Modicon M580 System as defined by Reference
Topology SEO1. Please refer to the manuals listed in chapter 2.1.1 for an explanation on how to use hard-
and software provided by Schneider Electric.

2.3 Operable Asset Management System

This document assumes an operable Endress+Hauser PAM System as defined by Reference Topology
SEO1. Please refer to manuals listed in chapter 2.1.2 for installing of hardware and software provided by
Endress+Hauser.

SD01463S/04/EN/01.15 5/96
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2.4 Operable Field Network Infrastructure

This document assumes an operable PROFIBUS DP / PA field network infrastructure as defined by
Reference Topology SEO1. Please refer to manuals listed in chapter 2.1.3 for installing of hardware and
software provided by other parties.

2.5 Operable Field Devices

This document assumes an operable selection of Endress+Hauser PROFIBUS DP and PROFIBUS PA devices
connected via the field network infrastructure, as defined by Reference Topology SEO1. Each field device is
adequately powered and prepared with unique tag and PROFIBUS address. If required, please refer to
individual device manuals for further advice.

SD01463S/04/EN/01.15 6/96
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3 Basic Integration

This chapter describes the main workflow for integration of a PROFIBUS network and field devices into the
Schneider Electric Modicon M580 system by means of GSD. As a result, the cyclic PROFIBUS
communication is running and process values with status information are available within the control
strategy of the system for further processing.

3.1 System Configuration

3.1.1 New project

e Start the software Unity Pro XL.

B

Unity Pro XL

e (reate a new project with the menu “File> New...".

Unity Pro XL
[File View Tools PLC Help

B) New... Ctrl+M
ﬁgpen... Ctrl+0
Exit

e Select the PLC and Rack type.
In this example, the PLC BME P58 2040 is mounted on a Rack BME XBP 0800.

New Project
[] Show all versions
PLC Min0S Version  Description Cancel
Modicon M340
" Mordoon MEED -
BE P58 1020 o110 CPU 580-1 ETH distribued 10
~ EBMEP582020 01.10 CFU 580-2 ETH distributed 10
_ BMEPS330X CPU 5803 ETH ditriouted 10
ME P58 3040 CPU 580-3 ETH remete and distiibuted 10
ME P58 4020 CPU 5804 ETH distributed 10
ME P58 4040 CPU 5804 ETH remete and distibuted 10
& Momentum Uity
[ Premum
Guantum
Rack Description B
" Modicon M580 local drop | [
£ Rack =
BME XBP 0400 4 5LOTS BACKPLANE
BME XBF 0800 £ 5LOTS BACKPLANE b
BME XBF 1200 12 SLOTS BACKPLANE
BMX XBP 0400 4£5LOTS BACKPLANE ,
Froject Settings
[] Settings File: <default settings>

SD01463S/04/EN/01.15 7/96
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e Created Project structure.
File Edit View Services Tools Build PLC Debug Window Help

a=d B E @ &% S
.----me

Pm}ect Browser

%a Structural view

....... W= Project|

B @ Configuration
........... %R’ 0:PLC bus

........... m 0 : BME XBP 0400

e B, ) (P) : BMx CPS 2000
-8, 0(1) : BME P58 2040

4

3.1.2 Modicon M580 hardware configuration

3.1.2.1 PLCRack
e Double-click on the field “0: PLC bus” in the Project Browser view.
Project Browser

%a Structural view

....... a" Project
5 ........... @’ Configuration
-,

The PLC module is inserted automatically with the power supply CPS2000.

g |BME P58.2040 01.10 -

il

Bus: |

In our example, the Power Supply module CPS2010 is used.

O
Delete the current one by right-clicking on the symbol CPS2000 and select the menu

“Delete Module”.

SD01463S/04/EN/01.15 8/96
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] B3 8 .
i o Cut Ctrl+ X
il
Qop}r Ctrl+C
@_ Cirl+
Delete Maodule Del
Power Supply Budget...

o The power supply module is now deleted.

o Double-click on the empty module and select the correct power supply module. In this
case, it is the module BMX CPS 2010.

MNew Device @
Topological Address: 0.
Part Mumber Description
£ Modicon M580 local drop |

=1 Supply |
-~ BMXCPS 2000 | STANDARD AC POWER SUPPLY
[ BIVX CPS 2010 | STANDARD 1SOL DC POWER SUPPLY

-~ BMXCPS 3020 HIGH POWER 1SOL 24 TO 48 VDC POWER SUPFLY
;- BMXCPS 3500 HIGH POWER AC POWER SUFPLY
~~ BMXCPS 3540 HIGH POWER DC POWER SUPPLY

o PLCrack configuration.

3.1.2.2 PLCIP address

e Inthe Project Browser, double-click on the field “EIO".
Project Browser =l
%a Structural view

i, Project
- {3, Configuration

. B3R, 0:PLCbus

¢ B, 0:BME XBP 0400

(F) (F) : BMX CPS 2010

0 (1) : BME P58 2040

L)

SD01463S/04/EN/01.15 9/96
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¢ Following window is displayed.

RIO DI0 Communicator Head

L] CommreadRioDiOE 1T Security | T ooty | [} As7P | 0 swwe | 10 w7P | 10 ServicePor
B Channel 0 4 L 1 ]
™.
™
e
[ Enforce scanty | [ Unlock Seauity

Autharized addresses

IP Address
192168101

S
DD

Subnet mask -
255.255.00 3

Zizgzzzz e
T FFEEFEE pIE

e (lick on the button “Unlock Security”. This enables the FTP/ TFTP / HTTP options.
{0 Security | T iPconiy | T A57P | T s | 10 7P | (T Servicerar |

FIP:  [Enabled -

TFTP : [Enabled -

HTTP :  [Enabled -

Access Control : [Disabled v]

Enforce Security Unlock Security

o Select the Tag “IPConfig”.
Configure the IP addresses according to the connected network.
In this example:
o The main PLCIP address is 10.126.105.30
o ThePLCIP address Ais 10.126.105.31
o The subnet maskis 255.255.252.0
o The default gateway IP address is 10.126.104.1

SD01463S/04/EN/01.15 10/96
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{0 Secumy | {00 1PConiig | T 2577 | {0 s | 10 7P | (T Servicerar |

IF addres= configuration

Main [P address 10 . 126, 105. 30
IF address & 0. 126, 105, 3

IF addres= B 0. 0. 0.0 [Used for Hot Standbey]
Subnetwark mazk 265. 286, 262. 0
Giateway addresz 0. we

CRA P address configuration

Drop N Device Name IF Address o~

e Save the configuration by clicking on the symbol “Validate” in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

e~ ]

3.1.2.3 PLCDTM

e C(lick on the menu Tools=>DTM Browser in the Tool bar.
File Edit Wiew Ser\.rices[Tools Build PLC Debug Window Help

a=E s | 2= 4| + Project Browser Alt+1 5
2 M E |§l i | Hardware Catalog Alt+2
s | [@ Types Library Browser Alt+3
Operator Screen Library Alt+4 F
%a Structural view
Search / Replace Alt+5 —
@« Configuration Diagnostic Viewer Alt+6
PLC Screen Alt+7
Variable Window Alt+8
Data Editor Alt+9
DTM Browser Alt+Shift+1
Bookmarks Alt+Shift+2

e The DTM Browser displays already the configured PLC IP address, 10.126.105.30 in this example.
Double-click on the DTM “BMEP58 ECPU".

DTM Browser
E < 10.125.105.30 > EMEPS8_ECPU

#f, Remote Bus
----- %, Distributed Bus

¢ Following window is displayed.

SD01463S/04/EN/01.15 11/96



Schneider

Endress+Hauser £71]

People for Process Automation

Integration Tutorial SEO1

Source Address:

Source IP Address:

Sub-Metwork Mask:

EtherMet/TF Network Detection:

Begin detection range address:

End detection range address:

Modbus Metwork Detection:

Begin detection range address:

End detection range address:

Version 1.00.00

10.126.106.208 hd

205 .20G GRZoEa

10 .12 . 104 . 1

o . 126 . 107 . 254

w0 .16 . 104 . 1

10 .12 . 107 . 254

e Check the source IP address (IP address of the engineering station).

e Re-adjust the Ethernet/IP Network Detection and Modbus Network Detection Range addresses
according to the network configuration.

EtherMNet/IP Network Detection:

Begin detection range address:

End detection range address:

Modbus Metwork Detection:

Begin detection range address:

End detection range address:

7

N

o . 126 . 105 . 28

0 .12 .15 . 33

0 . 126 . 105 . 28

w ., 126 . 105 . 3

e (lick on the button “Apply” to validate the changes.

QK ] l Cancel

]

|

Apply

e Confirm the Message Box by clicking on the button “Yes".

Modification Authorization 3

l-\ Do you confirm the modification 7

[ ves ][ Mo

SD01463S/04/EN/01.15
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3.1.3 Modicon X80 hardware configuration
3.1.3.1 170 platform Rack

e Double-click on the field “2: EIO bus” in the Project Browser view.
I'jlnj‘ec'lnﬁmwser

%a Structural view

------- @, Project
-3, Configuration
5@, 0:PLC bus
]]IU, 0 : BME XBP 0400
B, ) (P : BMX CPS 2010
T, 0 (0 : BME PSB 2040

e This opens the following window. Double-click on the white square.

Bus:

e Select following parameters according to the SEO1 topology architecture:
o The topological address 1
o The Rack BME XBP 0400
o The EIO Drop adapter BME CRA 312 10.2

CommHeadRIODIOE 01.00 - Connections configured: 0 |

New Device
:
Topological Address:  [1..8] 1
Part Number Description Help
" Modicon M580 remote drop |
& Rack
BME XBP 0800 85LOTS BACKPLANE
E XBF 1200 2 5L0TS BACKPLANE
X XBF 0400 LOTS BACKPLA
X XBF 0600 LOTS BACKFLA
X XBF 0200 LOTS BACKPLA
X XBF 1200 2 5LOTS BACKPLANE

=[]
BMx CRA 312 00.2
BMx CRA& 31210.2

SD01463S/04/EN/01.15 13/96
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Inserted EIO Drop adapter BME CRA 312 10.2

L]
Bus | 2 CommHesdRIODIOE 01.00 Connections configured: 1
1
e Double-click on the 1* empty slot to insert the power supply CPS2010.

New Device @
T
'

Topological Addiess:

Part Number Description
5 Modicon M580 remote drop
B Supply | — S
+ BMX.CPS 2000 STANDARD AC POWER SUPPLY

[l BMX CPS 2010 | STANDARD ISOL DC POWER SUPPLY
" BXCPS 3020 | HIGH POWER ISOL 24 T0 48 VDC POVIER SUPFLY
- BXCPS 3500 [ HIGH POWER AC POWER SUPPLY_

BMX CPS 3540 _| HIGH POWER DC POWER SUPPLY

e 1/0 platform rack.

o

3.1.3.2 1/0 platform EIO adapter IP address

A default IP address is automatically set for the EIO adapter BME CRA 312 10.2 according to the PLC and

network configuration.

Click on the tag “Parameters” to display the EIO adapter IP address.

L]
#B0 performance EID adapter
I overiew | | Device ooT | ) RSTP | [B) SMtP | [P SenicePor | [f) P | ' TimeStamping

Address information

Dlevice Mame : EMECRA_D01 Tens: I o Ones: 1 ¥

IP Address : 0 . 126 . 105 . 32

S 265 . 285 . 2. 0

Hold up time

Hold up time : 1000 = ms

Connection parameter

5 . Application trigger
CR#& -» Scanner RF : Soanner - CRA BRI
MAST: B2 ms E2 ms
e If needed, the EIO adapter IP address can be changed.

14/96
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In the Project Browser view, double-click on the field “EIO” of the menu “0: PLC Bus".

Project Browser

%a Structural view

-3, Project
a, Configuration
Bl 0+ PLC bus
7l 0 : BME XBP 0400
o T, (F) (F) 2 BMX CPS 2010
-, 0 (1) : BME P58 2040

o The EIO adapter IP address is inserted in the part “CRA IP address configuration”.

{0 Secumy | {00 1PConiig | T 2577 | {0 swwe | 10 7P | (T Servicerar |

IF addres= configuration

Main [P address 10 . 126, 105. 30
IP address A 0. 126, 05, H

IF addres= B 0. 0. 0.0 [Used for Hot Standbey)
Subnetwark mazk 265. 2686 262. 0
Giateway address 0 . 126. 104, 1

CRA P address configuration

Drop N°f  Device Name IP Address
1 BMECHA_0m 10.126.106.32

o Double-click on the IP address.
CRA IF address configuration

Drop N Device Name : IP Address
1 EMECRA_001

o Change the IP address to the requested one.
CRA IF address configuration

Drop N Device Name IP Address
1 EMECRA_001 10.126.106.25

o Save the configuration by clicking on the symbol “Validate" in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

3 4

g = & sy =] &

Es G Validate h

For the next steps, the EIO adapter IP address is set to the IP address 10.126.105.32.

SD01463S/04/EN/01.15
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3.1.3.3 170 platform EIO adapter device name
[}

In the Project Browser, double-click on the field “0 : BME CRA 312 10.2".
Project Browser

%a Structural view

a, Configuration
%m, 0:PLChus

= 2 : EIQ Bus

t}-v 1: Modicon M580 remote drop

- [[lll, © : BME ¥BP 0400

----- (P} (P) : BMX CPS 2010
Bo

e Configure the device name to the requested one with the fields “Ten” and “Ones".
In this example, device name is BMECRA_001.
™ overview | % Device ooT | [ RSTP | [ Swmp | [ Senvicerort | [ Parameters | [ TimeStamping |
Addresz information
Device Mame : EMECRA_00 Teire p o Ones: 1 =
IF Address: o . 128 . 08 . 32
U=t 265 . 285 . 252 . 0
L]

Set this device name on the EIO adapter thanks to the rotary switches.

In this example, the address is set to 1 for the device name BMECRA_001.
0 ,,Clear

1610, 2¢° 50,5
HORTO}
SRy

& (]
/8 \ g\
LTens pevice Ones

Save the configuration by clicking on the symbol “Validate” in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

a=H
&

L2

Bx|e

3.1.4 DRS switch configuration

Connect the engineering station directly to the DRS switch

Start the software Ethernet Switch Configurator.

SD01463S/04/EN/01.15

Version 1.00.00
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e The function “scan” is automatically started.
Connected devices are displayed in the window. The connected DRS switch can be identified with
the MAC address which is written on the device. If the DRS switch was never configured, the IP
address is 0.0.0.0.

e Select the MAC address field and click on the menu “Properties”.
In this example, the MAC address is 00:80:63:F2:82:0E.

"""'.-Q.‘__Ethernet Switch Configurator
File Edit Options 7

¥

Signal

&

Properties

2

i vy

Telnet

Id MAC Address Writable

1|00:580:63:F2:52:0E

e Configure the DRS switch IP address according to the connected network.
In this example:
o DRS switch IP address is 10.126.105.28
o Net Mask address is 255.255.252.0

o Default Gateway is 10.126.104.1

"% Ethernet Switch Configurator -0 x|
File Edit ©Options 7

v | & 2| W |9 @ %

Signal | Properties | W | Telnet | Ping | Rescan | Preferences
Id MAC Address ‘Writable I IP Address A I Met Mask. I Default Gateway | Product I Mame

S | x|

MaC Address: 00:30:63:F2:82:0E

Mame: |TCSESMOB3F23FL

~IP Configuration

IP Address: (10 .Jiz .Jws .[&  Setoefakoom |

Met Mask: EENERERRE Set Default (0.0,0,00 |

Defaulk Gateway: | 10 .| 126 .| 104 .| 1 Set Default {0.0,0,0) |
Save As Defaulk |

Ok | Zancel |

o (Click on the button “Ok” to save the settings.
o |IP settings have been updated.

SD01463S/04/EN/01.15 17/96
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“ay Ethernet Switch Configurator =10 x|
File Edit Options 7
9 4 2 8 | 9| @ %
Signal | Properties: | WA | Telnet | Ping | Rescan | Preferences
Id MAC Address Writable IP Address & Default Gakeway Product Mame

hek Mask,
10.126,105.258 2 2

1/00:80:63:F2:82:0 ﬂ

3.1.5 PRM Gateway configuration

3.1.5.1 DTM library

10.126.104.1

23F1 |TCSES

The installation of the DTM “Gateway DTM V1.2" is required in order to configure the PRM Gateway. This
library can be found on the PROFIBUS Remote Master CD-ROM.

e Once the Gateway DTM Library installed, the new components can be displayed in the DTM

catalog.
Click on the menu “Tools>Hardware Catalog”.

File Edit Wiew Services | Tools| Build PLC Debug Window Help

2 | « Project Browser Alt+1

HamBA | |-

e Select the Tag “DTM catalog” and click at on the button “Update” to display the new installed

components.
Hardware Catalog

i | Hardware Cataleg Alt+2 F

& {0*" devices Device Vendor

@ Devicetyes |8 ALTIVARTI Revison...|  Device Schneider Bectic | 27 |

b= Vendors B ALTI Device Schneider Electric 33
b= Groups q BME AHI 0812 Gateway Schneider Electric 10430 | 20140523
& Frotocols [ BMEAHD 0412 Gateway Schneider Electic | 1.0.49.0 | 20140523
i BMENOCD301 Communication Schneider Electric 1.5.13.0 20141118

E_ _ BMENOCO301 ffrom ... Device Schneider Electric 11
| & BMEMNOCD311 Communication Schneider Electric 15130 | 20141118

._BI'!IEI\I_OEQJH ffrom .. Device Schneider Electric 11

E_EMEPEBWZD ffrom E Device Schneider Electric 13

[ oo

4] 4] #]¥\ ElOBuUs A PLCbus }, DTM catalog /

e Following Message Box is displayed.
Click on the button “Yes".
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| Uni‘ly.l-’ln.')(L |_EI§_|
@ The DTM Catalog seems to be up of date\Would you like to update it?
[ Yes ] [ Mo
¢ Installed components
ig FRM Comm Communication Schneider Electric 1x
L] PREM Gateway Gateway Schneider Electric 1.2 201402-26
ig PRM Master Communication Schneider Electric 1x

3.1.5.2 DTM Browser project structure

3.1.5.2.1 PRM Gateway DTM

Click on the menu “Tools>DTM Browser” in the Tool bar.

|
o

.
File Edit Wiew Services ITooIs Build PLC Debug Window Help
e | Bz ¥ | ¥ Project Browser Alt+1
.‘-,51 1all=] |§k = | Hardware Catalog Alt+2
EE— [ Types Library Erowser Alt+3
Operator Screen Library Alt+4
%a Structural view
Search / Replace Alt+5
{3, Configuration Diagnostic Viewer Alt+6
i PLC Screen Alt+7
Variable Window Alt+8
Data Editor Alt+9
DTM Browser Alt+5hift+1
Bookmarks Alt+5hift+2
e The DTM Browser displays already the configured PLC IP address.
DTM Browser . .
=
=--§5% < 10.126.105.30 > BMEP58_ECPU
l"@ Remote Bus
5, Distributed Bus
e Right-click on the PLC and click on the menu “Add".
DTM Browser
{3y Host PC
=8
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e Select the PRM Gateway and add it to the DTM Browser project structure by clicking on the button

“Add DTM".
Add
Device Type Vendor Wersion Date -
E BMEP584020 from EDS) Device Schneider Electric 13
E BMEP584040 from EDS) Device Schneider Electric 13 |j
E BMX NOC04017 from EDS) Device Schneider Electric 1.1
E BMX NOCO401 Revision ... Device Schneider Blectric 21
E BMX NOC0402 from EDS) Device Schneider Electric 1.1
E ETE 1EI 0BE 085 PPO ffro... Device Schneider Blectric KX
E ETE 1El 12E 045 PPO ffro... Device Schneider Blectric KX
E ETB 1El 16C PO from E. .. Device Schneider Electric 36
E ETE 1El 16E FPPO from E... Device Schneider Electric 36
=] Genenc Device Device Schneider Blectic | 1.1.17.0
E Generic Device Bxplict Msg Device Schneider Bectric | 1.1.17.0
E Lexium 32 from EDS) Device Schneider Electric 1.1
E Modbus Device Device Schneider Bectric | 1.1.10.0 | 2011-04-27
‘1 PRM Gateway Schneider Hectric 3 2014-02-26
E Schneider TCSESMO4X0... Device Schneider Blectric 1.1
E Schneider TCSESMO4X.. Device Schneider Blectric 12
E Schneider TCSESMOGX... Device Schneider Blectric 12
E Schneider TCSESMO3X0... Device Schneider Blectric 1.1
B Schneider TCSESMORY Nevices Schneider Flertrir 11 2

e C(lick on the button “OK".
Properties of device ==

General |Dem'c.eir|forrnatior1 I DTM information | Protocol information

DTM name management

Alias name :

Tag name :

Default 1/0 vision management

Default input 110 vision
Variable name : PRM_Gateway_IN

Default output 1/0 vision
Variable name : PRM_Gateway_OUT

e The PRM Gateway is now part of the DTM browser project structure.

DTM Browser

{3 Host PC

=88 < 10.125.105.30 > BMEPS8_ECPU
-5, Remote Bus

-5y, Distributed Bus
x I

B8 ] < Modbus: 10,126, 105.33 > PRM_Gateway
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e Double-click on the PRM Gateway DTM.

This corresponds to the menu “Offline Parameter”.
DTM Browser

{30 Host PC

B- [E < 10.125.105.30 > BMEP58_ECPU
----- %, Remote Bus
% Distributed Bus
L,@ < Modbus: 10. 126, 105. 33 > PRM_Gateway

Version 1.00.00

e The PRM Gateway MAC address must be configured. This address is written on the PRM Gateway.

g [ G Schneider
i Profibus Remote Master Configuration Toal L Electric
=] PRM Master Configuration -
... General Settings Factory IP Address
- Profibus Master Configuration Factory IP Address is derived from the MAC Address printed on the PRM label
..o Basic Settings
ﬁ Advanced Settings Factory IP Address:
.= 10 Scanning MAC Address: 0 80 F4 FF 0 0 0 .10 0 . 1
This IP Address will be used if the PRM Gateway DTM cannot connect to the PRM via the
dedicated IP Address.
Dedicated IP Address
Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be also stored in the
PRM configuration file
IP Address:
10 .126 . 105 . 33
Subnet Mask: =
255 255 252 o
Default gateway:
10 . 126 . 105 . 30
DHCP/FOR Server
Parameters of this section need to be filled if you want to use a DHCP/FDR server.
Create an entry for this device name in the DHCP server.
Device Name
TCSEGPAZ3F14F 000 Extension[000..159](rotary switches value)
D Backup the PRM configuration in FOR server on downioad. 1
ok | [ conce Aoply Help
<Il= Disconnected [0 Dataset
EElPRM_Gaten..
e Enter the MAC address :
In this example, the MAC address is 00:80:F4:FF:2C:29.
Factory IP Address
Factory IP Address is derived from the MAC Address printed on the PRM label.
f Factory IP Address:
MALC Address: D || &0 || F4 || FF || 2C Zﬂ 0 .10 . 44 1

This IP Address will be used if the PRM Gateway DT cannot connect to the PRM via the
dedicated IP Address.
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e (lick on the button “Apply” to validate the changes.

oK ] ’ Cancel ] ’ Apply I [ Help

3.1.5.2.3 PRM Gateway IP address

e Adefault IP address is automatically set for the PRM Gateway according to the PLC and network
configuration.
This IP address cannot be edited in this menu.

R FRM Gateway 3 A
, chneider
LI Profibus Remote Master Corfiguration Tool Electric

=5 PRM Master Configuration

[ 4 General Settings| Factory IP Address

(@ Profibus Master Configuration Factory IP Address is derived from the MAC Address printed on the PRM label.

& Basic Settings
& Advanced Settings
= 10 Scanning MAC Address: 0 || 80 || F4 | FF| 2c| 22 10 .10 . 44 . &

Factory IP Address:

This IP Address will be used if the PRM Gateway DTM cannot connect to the PRM via the
dedicated IP Address.
Dedicated IP Address

Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be also stored in the
PRM cenfiguration file

IP Address:
10 . 126 . 105

m

Subnet Mask:

Default gateway:
10 . 126 . 105 . 30

DHCPFOR: Server
Parameters of this section need to be filled if you want to use a DHCP/FDR server.
Create an entry for this device name in the DHCP server.

Device Name

TCSEGPAZIF14F 000 Extension[000..159](rotary switches value)

D Backup the PRM configuration in FDR server on download.

oK | [ concd Apply Help

l= Disconnected 0 Dataset

-EFHM_Gatew...l

e The PRM Gateway IP address can be edited by opening the PLC DTM.

In the DTM Browser view, double-click on the DTM “BMEP58_ECPU".
DTM Browser

{33 HostPC
(=8 17 < 10.126. 105.30 > BMEP58_ECFU
b2y, Remote Bus
E| P'@ Distributed Bus

------ L@ « Modbus: 10. 126, 105.33 > PRM_Gateway
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¢ Inthe device list, select the PRM Gateway.

BMEPS58_ECPU
li' Communication
BME P58 2040

Channel Properties
L. TCRaP
Services
fo Address Server
EtherMet/IP Local Slaves
E| Local Slavel
Items

Local Slave 2
Items
Local Slave 3
- tems
=~  Device List
: [001] BMECRA_00L <EIP: 10.126.105.32>
- Exclusive Owner
s [036] PRM_Gateway <MDB: 10.126.105.33>
Logging

e Select the Tag “Address Setting”.
- Address Setting | Request Setting

1P Configuration

IP Address: 100 p19sc. 105 C08E
Subnet Mask: 255 . 255 . 252 . 0
Gateway: 0 . 126 . 105 . 30

e Enter the new IP address and click on the keyboard button “Enter”.
Address Setting | Request Setting

IP Configuration

IP Address: # W .12, 105. 34
Subnet Mask: 255 . 255 . 252 . ©
Gateway: 0 . 126 . 105 . 30

e Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

e Asa consequence:

o The DTM Browser project structure is automatically updated.
DTM Browser

{30 Host PC

=88 < 10.126.105.30 > BMERS8_ECFU
l"@ Remote Bus

-3, Distributed Bus

B8 < Modbus: 10.126. 105.34 > PRM_Gateway
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o The IP address in the PRM Master Configuration is automatically updated.
Dedicated IP Address

Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be alzo stored in the
PRM configuration file

IP Address:
10 . 126 . 105 . 34

Subnet Mask:

255 . 255 .252 . @
Default gateway:

10 . 126 . 105 . 30

For the next steps, the PRM Gateway IP address is set to the IP address 10.126.105.33.

3.1.5.3 PRM Gateway working mode

The PRM Gateway can be configured either with DHCP mode for dynamic IP assignment or Store mode for
fixed IP address. The mode must be selected on the PRM Gateway by using the rotary switches and
configured accordingly in the DTM browser of Unity Pro.

3.1.5.3.1 Clear IP steps
This step is needed to delete the PRM configuration file.

e Shut down the PRM Gateway power supply.

e Disconnect the PRM Gateway Ethernet cable.

e Remove the PRM Gateway from its backplane.

e Set the address 0 for the upper rotary switch and E for the lower rotary switch.

¢ Mount the PRM Gateway on its backplane.
e Energize the PRM Gateway.
e The PRM Gateway LED SF is red.
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3.1.5.3.2 DHCP Mode configuration steps

In DHCP mode, the PRM Gateway device name needs to be configured. The device name is made of a
fixed part (“TCSEGPA23F14F)" as well as a 3 digits numerical extension, whose value is between 0 and
159. This numerical extension corresponds to the code set on the PRM Gateway rotary switches.

In the following DHCP configuration example, the configured device name is “TCSEGPA23F14F001".

e DTM configuration

o Inthe DTM Browser view, double-click on the DTM “BMEP58_ECPU".
DTM Browser

' {30 Host PC

(=8 17 < 10.126. 105.30 > BMEP58_ECFU
.2, Remote Bus
-3, Distributed Bus
i L\; « Modbus: 10. 126, 105.33 > PRM_Gateway

o Inthe device list, select the PRM Gateway.

%= BMEP5E_ECPU
li' Communication

BME P58 2040

- Channel Properties

C o TCPAP

E| Services

: Address Server

,__—_| EtherMet/IP Local Slaves
B Local Slave 1l

f Items

E| Local Slave 2

i Items

E| Local Slave 3
. Items

- Device List

E| [001] BMECRA_D01 <EIP: 10.126.105.32>

o Exclusive Owner

- [036] PRM_Gateway <MDB: 10126105.33=
Logging

o Select the Tag “Address Setting”.
The DHCP mode is in status “Disabled"”.
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Address Setting | Request Setting

IP Configuration

People for Process Automation

IP Address: 10 . 125 . 105 . 33

Subnet Mask: 255 . 255 .252 . O

Gateway: 10 . 1xs . 105 . 30

Address Server

DHCP for this device: Disabled -
Identified by: Device Name
Identifier: TCSEGPAZIF 147000

o Select the option “Enable” and change the identifier from TCSEGPA23F14F000 to
TCSEGPA23F14F001.

Address Server

DHCP for this device: f [Enabled -
Identified by: Device Name
Identifier: TCSEGPAZ23F14F001

o Save the new settings by clicking on the button “Apply”.

Lo O em ]

o Double-click on the PRM Gateway DTM.
DTM Browser

{33 HostPC
E---[_E < 10.126.105.30 > BMEPS8_ECPU

% Remote Bus

%4, Distributed Bus
e L,\; < Modbus: 10. 126, 105. 33 > PRM_Gateway

o The device name is automatically updated to the new device name “TCSEGPA23F14F001".
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DHCPIFDR Server
Parameters of this section need to be filed if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.

Device Name

TCSEGPAZ23F14F 001 Extension[000..158](rotary switches value)

|:| Backup the PRM configuration in FDR server on download.

o Select the option “Backup the PRM configuration in FDR server on Download".

DHCR/FDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.
Device Name

TCSEGPAZAF14F o001 Extension[000..159](rotary switches value)

fﬂackup the PRM configuration in FOR server on download.

o Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

¢ PRM address configuration

Realize at first a Clear IP as explained in the previous chapter.

Shut down the PRM Gateway power supply.

Remove the PRM Gateway from its backplane.

Set the address 0 for the upper rotary switch and 1 for the lower rotary switch.

o O O O

Mount the PRM Gateway on its backplane.
Energize the PRM Gateway.
The PRM Gateway LED SF is red.
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Remarks:

The DHCP mode allows an address configuration between 0 and 159. That means device name from
TCSEGPA23F14F000 to TCSEGPA23F14F159. The two first digits correspond to the upper rotary switch
value multiplied by a factor 10 and the last digit corresponds to the lower rotary switch value.

e Rotary switches configuration example for device name TCSEGPA23F14F148:
"148"

«14" are the two first digits of 148

(14)10=(E) 16

.8" is the last digit of 148

(8)10=1(8) 16

=>» Schneider Electric recommends not using names between TCSEGPA23F14F060 and
TCSEGPA23F14F099.

3.1.5.3.3 Stored mode configuration steps

e DTM configuration
o Inthe DTM Browser view, double-click on the DTM BMEP58 ECPU.
DTM Browser

{3 Host PC
SR 1] < 10.125.105.30 > BMEP58_ECPU

w24, Remate Bus
=-%g, Distributed Bus
. L,it, < Modbus: 10, 126, 105,33 = PRM_Gateway

o Inthe device list, select the PRM Gateway.

BMEP58_ECPU
|i' Communication
BME P58 2040

=~ Channel Properties

i TCR/IP
B~ Services

L Address Server
EtherMet/IP Local Slaves
Local Slave1

Iterns
Local Slave 2
- Items
Local Slave 3
Tterns
=~  Device List
: [001] BMECRA_001 <EIP: 10.126.105.32>

- Exclusive Owner
[036] PRM_Gateway <MDB: 10.126.10533>

..... Logging
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o Select the Tag “Address Setting” and select the status “Disabled”.

- Address Setting | Request Setting

IP Configuration

IP Address: 0 . 125, 105 . 33
Subnet Mask: 55 . 255 .252 . 0
Gateway: 0 .12 . 105. 30

Address Server

DHCP for this device: f lDisabIed -
Identified by: Device Name
Identifier: TCSEGPAZ23F14F001

o Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

o Double-click on the PRM Gateway DTM.
DTM Browser

{30 Host PC

=48 < 10.125.105.30 »» BMEPSB_ECPU
Dﬂl; Remate Bus
-4, Distributed Bus

i L_@ < Modbus: 10,126, 105.33 > PRM_Gateway

o This disables automatically the DHCP mode.
DHCPRIFDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

D:reate an entry for this device name in the DHCP server.

Device Name

TCSEGPAZIF14F 01 Extension[000..155)(rotary switches value)

Backup the PRM configuration in FDR server on download.
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o Unselect the option “Backup the PRM configuration in FDR server on download”.

DHCRIFDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.
Device Name

TCSEGPAZAF14F o001 Extension[000..159](rotary switches value)

f |:| Backup the PRM configuration in FDR server on download.

o Save the new settings by clicking on the button “Apply".

oK || cancd [ Aeey

e PRM address configuration

Realize at first a Clear IP as explained in the previous chapter.
Shut down the PRM Gateway power supply.

Remove the PRM Gateway from its backplane.

Configure the Store Mode.

o O O O

Set the address 0 for the upper rotary switch and C for the lower rotary switch.

Mount the PRM Gateway on its backplane.
Energize the PRM Gateway.
The PRM Gateway LED SF is red.

For the next steps, the PRM Gateway IP address is configured with the DHCP mode, with the device name
“TCSEGPA23F14F001".
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3.1.6 Connection to PLC

The first download will have to be done with the USB interface because no IP addresses are set in the
PLC.

In this example, the PLC IP address is at first downloaded via USB. Then, it is the Ethernet connection
which is used to download the other parts of the project configuration.

3.1.6.1 Connection via USB interface

e (Connect the USB cable from the PLC USB port to the engineering station one.

¢ Inthe tool bar, click on the menu “PLC>Set Address".
File Edit View Services Tools Build Debug Window Help

g =E | Connect Ctrl+K
e | Set Address...
= M HE & 5
e Select the Address type “SYS” and the Media type “USB".

Set Address [ % [zl

v FLC Simulatar
Bandwidth...
Address Address
7] - 127.0.0.1 -
tedia tedia
[ Communication Parameters Communication Parameters ] [ Cancel l

[¥] Speed rate auto-adaptation at the end of download

Test if the connection is established by clicking on the button “Test Connection”.
o If successful, following message is displayed.
o Click on the button “OK".
UnityXL (=3

) Successfully connected to the currently selected target.
4

e (lick on the button “OK" to close the window “Set Address”.
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3.1.6.2 IP settings configuration download via USB
e Download the IP configuration in the PLC.
—>Refer to part 3.4.1 Project Compilation and part 3.4.2.1 Project Download in PLC to proceed.
3.1.6.3 Connection via Ethernet

¢ Inthe tool bar, click on the menu "PLC>Set Address".
File Edit View Services Tools Build Debug Window Help

=3 : Connect Ctrl+K
= R —
= -_-:-: Le" ) |

e Enter the PLCIP address as Address type and select the Media type “TCPIP".
In this example, the PLCIP address is 10.126.105.30.
.SetAddlss

(5| [nEsel]
v PLC Sirmlator
B andwidth...
Address Address
Test C li
10.126.105.30 - 127.0.0.1 -
Media Media
l Communication Parameters Communication Parameters l l Cancel ]
Speed rate auto-adaptation at the end of download Help

e Test if the connection is established by clicking on the button “Test Connection”.
o If successful, following message is displayed.

o Click on the button “"OK".
UnityXL (=22

:] Successfully connected to the currently selected target.

e (lick on the button “OK” to close the window “Set Address”.
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3.2 Field Network Configuration with GSD

3.2.1

PROFIBUS master settings configuration

e Double-click on the PRM Gateway DTM.

DTM Browser

{30 Host PC

=48 < 10.126.105.30 > BMEPS8_ECPU

: 3%1_?.; Remote Bus

=58 Distributed Bus
e

e Basic Settings configuration

B8 ] < Modbus: 10,126, 105.33 > PRM_Gateway

Version 1.00.00

o Configure the requested Baud rate, 500 kBaud in this example.
All standard Baud rates are available.
Configure the PROFIBUS master station address, @1 in this example.

Configure the HSA address, @126 in this example.

Bf PRM Master Cenfiguration
iﬁ General Settings
af Profibus Master Configuration
: f Basic Settings
; f Advanced Settings
e f 10 Scanning

e Advanced Settings.

o Profibus Basic Settings

Baud Rate:

TS: Profibus Station Address:

HSA: Highest Station Address:

o These timing parameters are automatically calculated.

@ Management -

TTR (Local): P
TTR (Total): # [ s
4 193

o Others Timings Management -

GAP: Gap Update Factor: m 2
TSL: Slot time: 7 |20
TRO'Y: Ready time: Bl |1
TQUE Quist Time: [0
© Calculated Timing -

Tid1: Time Idle 1: 3T
Tid2: Time Idle 2: S 10
© Profibus Cycle:

Profibus Cycle: j [ 3
Recommended Profibus Cycle: 3

thits

tbits

thits

thits

tbits

thits.

tbits

& Error Management -
Token Retry Limit:
Token Error Limit:
Message Retry Limit:

Response Error Limit:

MIN_TSDR: Smallest Station:

MAX_TSDR: Largest Station:

TSET: Setup Time:

o Devices Watchdog —

Default Devices Watchdog:

Minimum Devices Watchdog:

125
3
4
1
15
=ER toits
A F 10 s
m 1 thits
# [/ 15 ms
Faa ms
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o To edit them manually, select the check box and change the value.

& mr Management —

TTR (Local): 7 ses thits
TTR (Total): rd 1000 thits
= 2 ms.

o The standard parameter is written back when the check box is unselected.

O R Management —

TTR (Local): e thits
TTR (Total): rd [EF] 965 thits
= 1.93 ms

=>» Schneider Electric Recommended PROFIBUS cycle time = 1.5 x TTR

o 10 Scanning
Other timing parameters can be changed, as the PRM Watchdog time.

PLC Settings

5] Repetitive Rate £ Health Timeout -

Value: i [l ms Value: 1500 ms
Step: 5 ms
Recommended Value: f 5 ms

PRM Settings

o PRM Watchdog o Profibus Cycle:

Value: f |:| 300 ms Profibus Cycle: f 3 ms

e Save the new settings by clicking on the button “Apply”.

oK ] l Cancel ] l Apply
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3.2.2 GSD Library
3.2.2.1 GSD files import

e Inthe DTM browser, right-click on the PRM Gateway DTM and select the menu “Device

Menu->Additional functions>Add GSD Library".

{33 Host PC
=-§8 < 10.126.105.30 > BMEPS8_ECPU
5@ Remote Bus
EE‘E Distributed Bus

Delete Del
Field bus discovery

Sort by address

Connect

Disconnect

Load data from device
Store data to device

Copy
Paste

Online Parameter

Properties ALT+Enter

Print device ST

Configuration
Zoom out Ohserve

Expand all Diagnosis

Collapse all Additional functions Add GSD In Library

Remove GSD From Library
Set Physical Slave Address

Erase Configuration

1 : Modicon M580 remote drop R
MM o:eME xer 0400 Download Firmware
M ) ) : BMx cPs 2010

e (lick on the button “Next".

GSD

®
PIRIOJF]I
This Wizard allows you to add GSD files BiUJS

< Back MNext = Cancel Help
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Select the directory by using the button “Browse” and then click on the button “Next”.
65D Addition

PROF.‘
T6Ts

r~ Select the Location of the GSD File{s) :

© Add Flefs)
' Add all the GSD from the Directory

Directory or File Name :

I\megrat\on\GSD - Test execution SEOTNEH_PA_LE_Micropilot_(1559_0x01_0x01_PALIB

¥ Look in Subfolders

e GSD files usable are registered in the GSD Library. Select the location of the file(s) and
lick on Nexd: button to insert the GSD files in the base.

< Back Net > Cancel | Hep |

e The Micropilot GSD file is ready to be imported.
Click on the button “Next".

GSD Addition
®
PIRIO[F]!
#0006

Name | Status | File Name | Hardware Release | Softy

/ Micropilot S Mo emor. Ready to be added.  EH3x1553.GSD Al

sl

4| m |

List of the files ready to be added in the library. You can

i
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition WMiew Selected Fils I

Analyze Emors

= Back MNext > Cancel Help

e Theimportis completed.
Click on the button “Finish” to close the window.
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e Open the Hardware Catalog by clicking on the menu “Tools->Hardware Catalog”.
File Edit View Services ITuols Build PLC Debug Window

BeldsES E@ | v Project Browser Alt+1

45 [T = |Q_ o | Hardware Catalog Alt+2

DT - Types Library Browser Alt+3

| = pr—— Operator Screen Library Alt+4
ne 4

o (Click on the button “Update” to update the DTM catalog database.

T e

Device Type Wendar Version Date
E ALTIVART1 Revision ... Device Schneider Bectric 27
E ALTIVARY1 Revision ... Device Schneider Bectric 33
| BME AHI 0812 Gateway Schneider Electric 10450 | 20140523
BME AHO 0412 Gateway Schneider Electric 10450 | 20140523
i BMEMOCD301 Communication Schneider Hectric 15130 2014-11-18
E BMEMNOCO307 from ... Device Schneider Hectric 11
i BMEMOCD311 Communication Schneider Hectric 15130 2014-11-18
E BMEMNOCO317 from ... Device Schneider Hectric 11
E BMEF581020 from E... Device Schneider Hectric 13

——

[[4] r[»[\ Em0Bus A PLChus }, DTM catalog [

o Following Message Box is displayed.

Click on the button “Yes".
e — =

—
@ The DTM Catalog seems to be up of date\Would you like to update it?
A e

| Yes ] [ Nao

o Select the Tag “DTM catalog”.
The Micropilot GSD file is now in the database.

- All devices - Device Type Vendor ‘Version Date =
Device types oF  Liguisys M CL/CCM23 /DP /2.30 Device Endress+Hauser 1.5.152.344 20150318
& Vendors = BZF  Liquisys MCL/CCM2°3/PA/2.30 Device Endress+Hauser 1.5.152.344 20150318
- Advanced Micro Controls| ™| 777 Micropilot / FMR&c / PA / FW 1.00.22 / .. Device Endress-+Hauser 140126 20140516
~ AGM Electronics, Inc. 7 Micropilot / FMRSc / PA/ FW 1.01.22/ ... Device Endress+Hauser 15.0.168 2014-08-01 3
- Beckhoff Automation | Micropilot 5« from G5D) Endress+Hauser Profile 3.02
-~ Endress + Hauser ¥ Micropilot Il / FMR 23¢/ PA / V2.00 Device Endress-+Hauser 1.5.152.344 | 20150319
+ Endress+Hauser ¥ Micropilot M/ FMR 25¢ / PA / V04.00 Device Endress-+Hauser 15152344 | 20150319
+ HMS Industrial Networks Micropilot M / FMR 25 / PA / V5a Device Endress+Hauser 15152344 | 20150319
. ;- Rockwel Attomation Micropilot M / FMR Zoc / PA / V1.0 Device Endress+Hauser 15152344 | 20150319
4| 1 3 Micropilot M / FMR 2ec / PA /V2.00 Device Endress+Hauser 1.5.152.344 20150319 -
[ <[] E10Bus  PLChus }, DTM catalog
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e Two GSD files cannot have the same name. The name needs to be changed.
In this example, the target is to implement to GSD files which have the same name but other

Hardware Release and Software Release.

P S Ty — . —
® ®
PIRJOJF[ 1 PIRJO[F] !
BlUJS BJU[S
Name [ Status File Name Hardware Release | Software Release | Vendor Name Product Type
0 PROMAG 50 PA A GSD with a same version already exists. Ready EH3_1525GSD Al 3 Endress+Hauser PA
! PROMAG 50 PA Profile 3.0 Duplicated device name. EHIX1525G50 A3 Endress+Hauser

-/ PROMAG 50 PA Profile 3.0 No emor. Ready to be added.

4 1 | 3

List of the files ready to be added in the library. You can
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition.

View Selected File

Analyze Emors I
There is a duplicated device name in the list. The comesponding GSD will not be added.

< Back Next > Cancel | Hep |

EHXc1525GSD Endress + Hauser PA

4 [ 1 | +

List of the files ready to be added in the library. You can
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition.

View Selected File |

Analyze Emors |

There is a duplicated device name in the list. The comesponding GSD will not be added.

< Back Nezt > Cancel Help

e The name of the marked one needs to be changed.

G5D Addition

PROF)‘
BJU[S

Name | Status
€ PROMAG 50 PA A GSD with a same version already exists. Ready to b

0 PROMAG 50 PA Profile 3.0 hw3 A GSD with a same version already exists. Ready to by

w/ PROMAG 50 PA Profile 3.0 No emor. Ready to be added.

4 m | b

List of the files ready to be added in the library. You can

change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition. Miew Selected File
Analyze Emors |
< Back Next > Cancel | Hep |

e The two GSD files are located in the Hardware Catalog with 2 different names.

Device Type Vendor Version Date
= PROMAG 50 PA from GSD) | Device | Endress+Hauser | Profile 3.0 | |
=| PROMAG 50 PA Profile 3.0 w3 from G5D) | Device | Endress+Hauser | Profile 3.0 | |
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3.2.2.3 GSD family slave structure

e A GSD family slave structure is available in the Hardware Catalog with different sections as Device
types, Vendors, Groups and Protocol.

o All GSD drivers are sorted in the section:

o Device types—>Devices.

o Vendors>Endress+Hauser (2 times).
o Protocols>Profibus DPV1.
o]

Groups—>DTM specific.
Hardware Catalog
- All devices - Device Type Vendar Version Date =
Device types £ Prosonic M Profile 3.0 from G5D) Device Endress+Hauser Profile 3.0
Vendors E] Prosonic M from GSD) Device Endress+Hauser Profile 3.0
& (:3“"-'95 El Cerabar M 5¢ from GSD) Device Endress+Hauser Profile 3.02
- DTM Specfic =| |£]  Dettabar S evolution V.01 from GSD) Device Endress +Hauser Profile 3.02
- Blectrochemical Analy... || |Z Detiapilot M 5x firom GSD) Device Endress+Hauser Profile 3.02
! - Flow E] Levefflex 5 from GSD) Device Endress+Hauser Profile 3.02
Level £ Deltabar M 5 from GSD) Device Endress+Hauser Profile 3.02
- Not speciied £ Frowid 200 PA from GSD) Device Endress+Hauser Profile 3.02
- Pressure El Promag 100 DF from GSD) Device Endress+Hauser Profile 3.02 .
« |E] Corabar 5 evolution V4.01 firom GSD) Device Endress=Hauser Profils 3.02 El
3 = Micropilot B¢ from GSD) Device Endress+Hauser Profile 3.02 &
4[4[ »]r [\ E10Bus } PLCbus } DTM catalog

e Another way to display the GSD files is to right-click on the Gateway DTM and to select the menu
“Device menu—>Additional functions=>Remove GSD From Library”.

DTM Browser
{53 HostPC
E‘"E\? < 10,126,105,30 > BMEP58_ECPU
-5@ Remote Bus
=5 Distributed Bus
< Modbus: 10, 126.105.33 > PRM_{
< PRM_( y:40 > Prosoni
< PRM_Gateway:41 > Liquiline, Add...
< PRM_Gateway: 14 > PROMA Delete Del
< PRM_Gateway: 16 > Prosonit .
< PRM_Gateway:21 > TEMP_1
< PRM_Gateway: 11 > Cerabar
< PRM_Gateway:20 > Deltaba
« PRM_Gateway: 18 > Deltapil Connect
< PRM_Gateway: 19 > Micropil
L, < PRM_Gateway:45 > Promag,
£| <PRM_Gateway:42 > PROMAI Load data from device

Sort by address

Disconnect

Store data to device

Online Parameter

Properties ALT+Enter
3

Print device
Zoom in
Zoom out
Expand all Additional functions Add G5O In Library
Collapse all Remaove GSD From Library
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e Installed GSD files can be sorted according to the File Name/Manufacturer/Category/Device
Name.
|" GSD Deletion from Device Library =
PIRJO]F] I s
Soit by [Marutachrer =]

=]
=) Endress + Hauser

B¢l P4

B¢ PA

Prasonic b Profils 3.0
Prasonic § FMUA0

Delete Selected Fie(s] | ViewSelected Fie | Close | Heln

3.2.3 Field Device Configuration with GSD
3.2.3.1 New field device

e Inthe DTM browser, right-click on the PRM Gateway DTM and select the menu “Add".
DTM Browser '

{53 HostPC

=48 < 10.126.105.30 » BMEPS8_ECPU

P»Q_E Remote Bus

%8 Distributed Bus

RN - Modbus: 10,126, 105.33 = PRM_Gatewsauw

-

e Select the GSD file “Micropilot 5x” and click on the button “Add DTM".

Add ==
Device Type Vendaor i Date -
EF Liquisys M /CUM 23 /P... Device Endress+Hauser 5.15... | 20150319
LZF Liquisys M CL / CCMZ*3 /. Device Endress+Hauser 5.15... | 20150318
LEF Liquisys M CL / CCMZ*3 /.. Device Endress+Hauser 5.15.. | 20150318
TEH pilat / FMR%Sx / PA /.. Device Endress+Hauser 4.0... | 20140516
LZF Micropilat / FMR%c / PA /. Device Endress+Hauser 5. 2014-0801
I Micropilot 5x from GSD) i Endress+Hauser |
ZF Micropilet Il / FMR 23x / ... Device Endress+Hauser 8.15.. | 2M503-19
LF Micropilot M / FMR 28x /... Device Endress+Hauser | 1.5.15... | 20150319 |E|
LZF Micropilat M/ FMR 25« / ... Device Endress+Hauser 515 | 20150319 —
ZF Micropilot M / FMR 2xx / ... Device Endress+Hauser 5.15... | 20150319
LF Micropilot M/ FMR 2ac /.. Device Endress+Hauser | 1.5.15... | 20150319
LZF Micropilot M/ FMR 200 / ... Device Endress+Hauser 5.15... | 20150319
ZF Micropilot M / FMR 2xx / ... Device Endress+Hauser 5.15... | 20150319
LF  Mulicap / FEC 14 /V1.0 Device Endress+Hauser 5.15.. | 20150319
LZF Mycom S /CLM153 cond ... Device Endress+Hauser 5.15... | 20150319
ZF Mycom S /CLM153ind / .. Device Endress+Hauser 5.15.. | 20150319
AEF Mycom S /CPM 153 / PA.. Device Endress+Hauser 515, | 2050319
LZF Mycom S/ CPM 153 / PA Device Endress+Hauser 20150315
F_Mvnm Cond C/Clx 431 Device Frdress+Hanser 5 1F M15N319 7
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e Confirm the choice by clicking on the button “Yes".
Modification Authorization [-22]

l; Do you confirm the modification 7

= [

e (lick on the button “OK".

i’lnperﬁs of device ? .

General | Device ir ion | DTMir ion I Pratocol ir ion

DTM name management

e [\licropilot B¢ from GSD)

Tag name :

Default /O vision management
Defautt input 140 vision
Variable name : Micropilot_Fec_from_GSD_IN

Default output /0 vision
Variable name : Micropilot_%c_from_GSD_OUT

[ ok ][ canced |[ Hep |

e The Micropilot is inserted in the DTM browser Project structure with the address 126.
DTM Browser

{3 Host PC

B- [E < 10.126.105.30 > BMEP5S_ECPU
----- 3@ Remote Bus
E 3@ D|5tr|buhed Bus
=2 Lw < Modbus: 10,126, 105.33 = PRM_Gateway
%, < PRM_Gateway: 126 > Micropilot_5x_from_GSD
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3.2.3.2 10 modules configuration

e Double-click on the generic DTM “Micropilot_5x_from_GSD".

e This opens the device DTM configuration window.

Micropilot ¢ from GSD) - Endress+Hauser
Profibus Remote Master - Generic Device DTM - Schneider Electric

-4 Device Information
43 GSD View
.7 Device Parameters
E}--ﬁf Modules Configuration
$> AL OUT {Analog Input)
$> AL OUT {Analog Input)
$9 AL OUT (Analog Input)
$> AL OUT (Analog Input)
%) AL OUT (Analog Input)
$> AL OUT (Analog Input)
$> DL OUT (Digital Input)
-9 DL OUT (Digital Input)
%) DL OUT (Digital Input)
%2 DL OUT (Digital Input)
$> AQ: 5P (Analog Output)
99 A0: SP (Analog Output)
-9 AD: SP (Analog Output)
-8 AD: SP (Analog Output)
-9 DO: SP (Digital Output)
%) DO: 5P (Digital Output)
-9 DO: SP (Digital Output)
99 DO: SP (Digital Output)

e Select the menu “Modules Configuration”.
o The default 10 module configuration is already done according to GSD file.

=-B Micropilot 5x
B Py D;i(ﬂ"fmmtim @ Madules Configuration
© G50 View Informatior
V| Device Parameters
- Input Size (0- 244y 38
[EE’.-d Modules Configuration| i
$> AL QUT (Analog Input) Output Size [0 - 244) 2
AL QUT (Analog Input)
g e (Ana‘oglnzuﬂ Tofel /0 Size[1- 488 G5
$9 AL OUT (Analog Input) Humber of Configured Modules (1- 181 18
£ AL OUT (Analog Input)
$9 AL OUT (Analog Input) Modules in GSD
£ DL OUT (Digital Input)
g; DE OUT (Digital Input) Mame Input Output  Canfiguration =
|
£ DL OUT (Digital Input) A1: BUT (analog Input) 5 0 D42 B4 DKOB 0005
$# DL OUT (Digital Input) Dl: DUT [Digital Input) 2 0x91
#0 AQ: SP (Analog Output) 40: 5P (Analog Output] 0 5 032,034, 0408, 0405
#2 AO: SP (Analog Output] 40: 5P.AB.POS 7 5 0606, 0¢04, (486 008040 _
$2 AO: SP (Analog Output) R = - TS
@ A: SP (Analog Dutput)
% DO: SP (Digital Dutput)
ﬁ’ DO: SP (Digital Qutput) Configured Modules
$ DO: 5P (Digital Output)
H Input  Output  Configurat &
#2 DO: 5P (Digital Output) ame S S T
Al: OUT (Analog Input) g 0420484 0x08,0605 Add
A1: AUT (analog Input) 5 0 042, 034,0408, 0405
Al: OUT (Analog Input) 5 0 0142, 00840208005 Remove
A1: AUT (analog Input) 5 0 0nd2, 0340408005 _
P - - nnnnen oo o Hove Up
O T | ¢
Move Down

o Corresponding slot definition in GSD file:
For each slot, there is at first the default module and then the allowed one.
For example, for Slot(1):
= Default module is Module 1.
» Allowed modules are Module 1 and Module 17.
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Rkttt Additional keywords for module assignment — dddedodddedodddor
slotDefinition
slot(1) = "AI 1 (Analog Input)" 1,17
slot(2) = "AT 2 (Analog Input)" 1,17
slot(3) = "AI 3 (Aanalog Input)" 1,17
slot(4) = "AIL 4 (Aanalog Input)"” 1,17
Slot(5) = "AI 5 (Analog Input)"” 1,17
Slot(6) = "AI 6 (Analog Input)" 1,17
slot(7) = "DI 1 (Digital Input)" 2| 2,17
slot(8) = "DI 2 (Digital Input)" 22,17
slot(9) = "DI 3 (Digital Input)" 2)2,17
slot(10) = "DI 4 (Digital Input)" 22,17
slot(11) = "A0 1 (Analog Output)"” 3| 3,4,5,6,7,8,9,17
Slot(12) = "A0 2 (Analog Output)"” 3] 3,4,5,6,7,8,9,17
Slot(13) = "A0 3 (Analog Output)"” 3] 3,4,5,6,7,8,9,17
Slot(14) = "A0 4 (Analog Output)" 313,4,5,6,7,8,9,17
slot(15) = "p0 1 (Digital Output)" |10{10,11,12,13,14,15,16,17
slot(16) = "DO 2 (Digital OQutput)" |10f10,11,12,13,14,15,16,17
slot(17) = "DO0 3 (Digital Output)" |10/10,11,12,13,14.15,16,17
slot(18) = "Do 4 (Digital output)" |10/10,11,12,13,14.15,16,17
EndslotDefinition

Default modules

o Corresponding modules definition in GSD file
Module = "AI: OUT (Analog Input)" 0x42,0x84,0x08,0x05

EndModule

Module = "DI: OUT (Digital Input)" 0x91

EndModule

Module = "A0: SP (Analog Output)" 0x82,0x84,0x08,0x05

éndMuduWe

Module = "AO: SP,RB,POS" 0xC6,0x84,0x86,0x08,0x05,0x08,0x05,0x05,0x05
EndModule

Module = "AO: SP,CB" 0xC3,0x84,0x82,0x08,0x05,0x0A

EndModule

Module = "AO: SP,RB,POS,CB" 0xC7,0x84,60x89,0x08,0x05,0x08,0x05,0x05,0x05,0x0A
EndModule

Module = "AO: RC_IN,RC_OUT" O0xC4,0x84,0x84,0x08,0x05,0x08,0x05
EndMuduWe

Module = "AO: RC_IN,RC_OUT,CB" OxC5,0x84,0x87,0x08,0x05,0x08,0x05,0x0A
EndModule

Module = "AO: SP,RB,RC_IN,RC_OUT,POS,CB" OxCB,0x89,0x8E,0x08,0x05,0x08,0x05,0x08,0x05,0x08,0x05,0x05,0x05,0x0A
EndModule

Module = "DO: SP (Digital Output)" OxAl

EndModule

Module = "DO: SP,RB" OxC1,0x81,0x81,0x83

%ﬁdMudu1e

Module = "DO: SP,CB" OxC1,0x81,0x82,0x92

éﬁdModu1e

Module = "DO: SP,RB,CB" 0x(C1,0x81,0x84,0x93

%ﬁdMndu1e

Module = "DO: RC_IN,RC_OUT" 0xC1l,0x81,0x81,0x8C

EndModule

Module = "DO: RC_IN,RC_OUT,CB" OxC1l,0x81,0x84,0x9C

%adMudu1e

Module — "DO: SP,RB,RC_IN,RC_OUT,CB" OxCL,0x83,0x86,0x0F
16
EndModule

Module = "Free Place" 0x00
17

EndModule
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e This default 10 module configuration can be changed.
In the following example, the module 1 “Al" of Slot 1 is replaced by the module 17 “Free place”,

according to the GSD 10 module definition.

o Select the module “Al” and click on the button “Remove”.

=% E Micropilot 5x
-4 Device Information
€ GSD View
-7 Device Parameters
E--ﬁ' Medules Configuration

-8 AL OUT (Analog Input)
.. AL OUT (Analog Input)

99 AL OUT (Analog Input)
-8 AL OUT (Analog Input)
-9 AL OUT (Analog Input)
8@ AL OUT (Analog Input)
.. DI: OUT (Digital Input)

99 DI OUT (Digital Input)
.- DI OUT (Digital Input)
.- DI OUT (Digital Input)
-8 AO: SP (Analog Output)
.9 AO: SP (Analog Output)

92 AD: SP (Analog Dutput)
-8 AO: SP (Analog Output)

9 DO: 5P (Digital Output)
-8 DO: 5P (Digital Output]
-9 DO: SP (Digital Output)

9@ DO: SP (Digital Output)

o The module “Al” of slot 1 is deleted.

B--’/ Micropilot 5x

€9 Device Information

€ GSD View

7| Device Parameters

E|/ Modules Configuration
92 AL OUT (Analog Input)

-9 AL OUT (Analog Input)
42 AL OUT (Analog Input]

-9 AL OUT (Analog Input)
2 AL OUT (Analog Input)

.. DI: OUT (Digital Input)

-4 DI OUT (Digital Input)

.. DI: OUT (Digital Input)

-8 DI: OUT (Digital Input)

-9 AO: SP (Analog Output)

-89 AO: SP (Analog Output)
¥ AO: SP (Analog Output)

-8 AO: SP (Analog Output)
% DO: SP (Digital Qutput)

-9 DO: SP (Digital Output)
%2 DO: 5P (Digital Output)

-9 DO: SP (Digital Output)

€ Modules Configuration

Version 1.00.00

Informaticrn
Input Sige (0- 244 38
Dutput Size (0- 244 29
Total 1/0 Size (1 - 4381 B8
Mumber of Configured Madules [1 - 18]: 18
todules in GSD
Mame Input Output  Configuration =
Al QUT [Analog Input) 5 1} 0=42,0:84,0208,0<05 (o
DI OUT [Digital Input] 2 0 0=91
AQ: 5P [Analog Output] 1] 5 0x82 0484.0:08, 0405
AD: SPRBPOS 7 5 06, 0u84, 086,008, 0xl _

Sy

| »

Configured Modules

Output

Configuration

€ Modules Configuration

Al: OUT [Analog Input) 5 0 0x42.084.0:08,0:05
Al DUT [Analog Input) 5 0 042 0484008, 0x05
Al: OUT [Analog Input 5 0 0x42 [x84.0:08,0x05 =
;.l-n..na FE— r__r[_ - - .qnn.nmnnenr ;
Information
Input Size (0- 244 33
Dutput Size (0- 244 28
Total|/0 Size (1 -8 &
MNumber of Configured Modules (1 - 18): 17
Modules in GSD
Marme Input Output  Configuration =
A1 DUT [Analag Input] 5 o 0x42,0x84,0:08, 0205 4
DI OUT [Digital Input] 2 o 0x91
A SP [Analog Output] 1] 5 0182 04840108, 0x05
Al: SPRBPOS 7 ] 006 O34, 086, 0208,0:C _
(,-‘. rmen - - m—anmﬂmnimn’,
f Caonfigured Modules
Mame Input Output  Configuration =
Al: OUT [Analog Input]) g a 0x42,0:84,0:08,0:05 (I
A1 OUT [Analag Input] 5 o Dxd2,0x84 008, 0205
Al OUT [Bnalog Input] a o Dx42,0x84,0:08,0:05
Al: OUT [Analog Input 5 1] 0142 04840108, 0x05 =
‘..‘Vm.,“ T o= - A neennn e

]

Add
Femove
Maove Up

Move Diovn
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o Select the module “Free place” and click on the button “Add".

E|/ Micropilat 5x
€9 Device Information
& GSD View

& Modules Configuration

Infarmation
7| Device Parameters n
= / Modules Cenfiguration (gD |I= 20
-89 AL OUT (Analog Input) Output Size (0- 244 29
-8 AL OUT (Analog Input) &
Total 1/0 Size (1 - 488}
¥ AL OUT (Analog Input) otal 11D Size 1 - 458}
@ AL OUT (Analog Input) Number of Configured Modules [1 - 18] 17
-9 AL OUT (Analog Input)
-4 DI OUT (Digital Input) Modules in GSD
%9 DI OUT (Digital Input)
-9 DI OUT (Digital Input) Hame Input Output  Configuration e
-2 DI OUT (Digital Input) DO: RC_IN,RC_OUT 2 2 04C1.0481.0481,048C
92 AD: SP (Analog Output) DO: RC_INRC_OUT.CE 5 2 0wC1,0481,0x84,069C

-89 AQ: SP (Analog Output) DO: SP.RE.RC_IN.RC_OUT CB 7 4 0401 .0483.0486.0:9F  —
-8 AD: SP (Analog Output)

%’ AQ: 5P (Analog Output) 4] m ] »
-89 DO: SP (Digital Output)
.9 DO: SP (Digital Output)
-8 DO: SP (Digital Output) 7 Configured Modules

%9 DO: SP (Digital Output)

Mame Input Output  Configuration =
Al: OUT [Analog Input) 5 1] (1442 (1134, 008 005 [ -
A1 OUT [Analog Input) 5 o Owd2,0x84,0:08, 005
Al OUT [Analog Input] 5 0 (d2, 01840408, 0005 Remove
Al: OUT [Analog Input 5 1] (Oxd2.0x84. 0408 005 =
M - - fannnin ann o Mave Up
4 . ] ¢

Move Down

o The module “Free place” is added in the configuration but still not on the right slot.

B-f Micropilot 5x

€ Device Information
€ GSD View

7| Device Parameters
B,/ Modules Configuration

& Modules Configuration

Infarmation

Input Size (0244

4 AL OUT (Analog Input) Output Size (0- 244 28
-2 AL OUT (Analog Input)
g AL OUT (Analog Input) R ol
3, AL OUT (Analog Input) Mumber of Configured Modules [1 - 18} 18
#9 AL OUT (Analog Input)
-89 DL OUT (Digital Input) Modules in GSD
-2 DI OUT (Digital Input)
$> DL QUT (Digital Input) Mame Input Output  Configuration =
$> DI QUT (Digital Input) DO: RC_INRC_OUT 2 2 OxC1.0x81 0x81,0x8C
%) AQ: 5P (Analog Cutput) D0: RC_INRC_OUT.CE 5} 2 0%C1.0x81.0x84.059C
% AD: SP (Analog Output) DO: SP.RB.AC_INRC_OUT OB 7 4 DCT (03 B8 S —
§> AO: SP (Analog Output) Free Place 1] 1] 0x00 =
? AQ: SP (Analog Output) 4 [T} |
$2 DO: 5P (Digital Output)
.29 DO: SP (Digital Output)
.4 DO: SP (Digital Output) 7 Canfigured Modules
SRu{Bigrtal Output) MHame Input Output  Configuration g
DO: 5P [Digital Output] o 2 ] A
D0O: 5P (Digital Output] 1] 2 0=l
D0: 5P [Digital Dutput) 0 2 (il

Move Down
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e Select the module “Free place” and click on the button “Move Up” to move the module to the

correct slot.
f Configured Maodules

Mame Input Output  Configuration =

D0: 5P (Digial Output] 1] 2 0=t aeld
D0: 5P (Digial Output] 1] 2 Oma1

D0: SF [Digital Dutput) 0 2 0241 Remaove

1

e Flace

towve Lip

Move Down

e The module “Free place” is now on the right slot.
[=-# Micropilot 5x

o Device Information

4% GSD View

] Device Parameters

) Modules Configuration

Infarmation
Irput Gize (0 - 2443, 33

(95 Free Place|
. AL OUT (Analog Input]
s EA::\:E I:xt; Total 140 Size (1 - 408 B

$> AL OUT (Analog Input) Mumber of Configured Modules (1 - 18] 18
$> AL OUT (Analeg Input)
8) AL OUT {Analeg Input)
.9 DI OUT (Digital Input)

Output Size [0 - 244 23

Modules in GSD

.82 DI OUT (Digital Input) Name Input  Output  Configuration =
$> DL OUT (Digital Input) D0: RC_IM RC_DUT 2 2 0nC1, 04810181, 0080
.42 DE OUT (Digital Input) D0: RC_IM.RC_OUT.CE 5 2 010281084, 025C
$> AQ: SP (Analog Output) D0: 5PRE.RC_IN.RC_OUT.CE 7 4 01,083,086, 0:9F m
.92 AQ: SP (Analog Output) Free Place 0 0 000 t
-89 A0: SP (Analog Output) < [0 T
#2 AD: 5P (Analog Output)
.89 DO: 5P (Digital Output)
? DO: 5P (Digital Output) f Configured Modules
& Pk oh (D!g!ta\ Sutput) MName Input Output  Configuration =
.89 DO: 5P (Digital Output) B
Free Place a a (0=00 o add
Al OUT [Analog Input] ] 1] (42 0x84,0-08 0205
Al OUT [&nalog Input) 5 1} (wd 2,084,008, 0205 Remave
Al: OUT [Analog Input] 5 a (42,0:84.0408,0:05 =
EORE T A = = Ere e L B3 Move Up
4 m |
Morve Dawn

e Save the configuration by clicking on the button “Apply”.

B == I [

=>» For the next steps, the 10 module configuration is the set to the default one.
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3.2.3.3 Field Device settings

e Double-click on the PRM_Gateway DTM.
DTM Browser

{30 Host PC

=88 < 10.125.105.30 > BMEPS8_ECPU
3%1_?.; Remote Bus
%@ Distributed Bus

=BV < Modbus: 10. 126, 105.33 > PRM_Gateway
< PRM_Gateway: 126 > Micropilot_5x_from_GSD

e The menu “Profibus Devices” is now available in the PRM Master Configuration view.

Profibus Remote Master Corfiguration Tool

[ PRM Gateway
2

& General Settings
@ Profibus Master Configuration
_.&F Basic Settings
o Advanced Settings
& [0 Scanning
=7 Profibus Devices

=B 126 Micropilot_5x from_GSD
.= DPVI Settings
= Profibus Settings
=@ 1o
! %’ Input Yariables
$> Output Variables

¢ PROFIBUS address
Select the menu "Profibus Devices”.

= PRM Master Configuration
& General Settings
¥ Profibus Master Configuration
& Basic Settings -
& s Sgettings Address Device Name
! & 10 Scanning 126 Micropilot_S=_from_... Endress+Hauser
-

5B 126 Micropilot_5x_from_GSD
= DPV1 Settings
& Profibus Settings
& Vo
$> Input Variables
! %’ Output Variables

o Aszsign Station Addresses to Devices

Vendor Type Version

Micropilot 5x ...  Profile 3.02

Address (0-128): 0 Assign Address Directly Applied to the selected device.

Give the new PROFIBUS address and click on the button “Assign Address”.

o]

In this example, the new PROFIBUS address is 19.

Address (0-128): [ Assign Address l Directty Applied to the selected device.
o New PROFIBUS slave address is updated.
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= PRM Master Configuration
& General Settings
---\@ Profibus Master Configuration

& Basic Settings ) .
& Ad d Setti Address  Device Name Vendor Type “ersion
Ivancel ngs

& 10 Scanning 19 | Micropiot_Sx_from GSD Micropilot 5x ... | Profile 3.02

E| Eﬂ Profibus Devices
19 Micropilot_5x_from_GSD
= DPV1 Settings

& Profibus Settings

o Aszsign Station Addresses to Devices

$> Input Variables
2 $> OQutput Variables

e DPV1 Settings
Select the menu “DPV1 Settings” and update the parameters if needed.

= PRM Master Configuration
= General Settings
- @ Profibus Master Configuration

€ DPV1 Settings

- Basic Settings DPV1 Enable: Enable Manufacturer Alarm:
& Advanced Settings
; & 10 Scanning WD Base 1ms: Enable Status Alarm:
£-# Profibus Devices
5B 19 Micropilot_5x_from_GSD Fail Safe: B Enable Update Alarm:
DPV1 Setti
- Enable Pull Plug Alarm: Check Cfg Mode: [}

& Profibus Settings
: o)
8’ I t Variabl Enable Process Alarm: ?.I:J[r;.aequence il 1Al of each type
nput Variables —ourt:

$> COutput Variables
Enable Diagnostic Alarm:

¢ PROFIBUS Settings
o The parameters “Profibus Settings” are configured automatically according to the GSD file.

& Device

ldent Number 0x 1559

O Profibus Settings

Byte Ordering: Big Endian -

MIN_TSDR: " thits
Watchdog: [F s00 ms
Minimum Slave Interval: [} x100 ps

&) Giobal Control

Sync Mode: D
Freeze Mode: |:|
i 2 3 4
Profibus Group: <
5 L] T 8

€3 Advanced Settings

Abort if Mo Answer (NA_To_Abort) |:|
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¢ 10 modules data structure configuration
The following part explains how to configure the device data structure, which is used in the logic.
This data structure is linked to the 10 module configuration done in the generic DTM.

o 10 Structure Names.
The 10 Structure Name is used to access to the data in the logic.

= PRM Master Configuration

.= General Settings ®
1@ Profibus Master Configuration

: = Basic Settings

& Ad